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System Requirements 
Your computer must have the following software for you to use the KanRoad  system: 
• Microsoft Windows 2003 with the latest service packs 
• Microsoft Internet Explorer 6.02 or greater 
 
 

Configuration Instructions 
There are a few configuration settings that need to be reviewed on your machine before you can access and 
use the KanRoad Reporting System.  The following instructions will guide you through the process of 
checking these settings and how to change them if necessary. 

Monitor Screen Size Setting 
The KanRoad Reporting System was developed for a screen resolution of 1024 x 768.  This screen size 
isn’t mandatory.  If you use a different size you will need to use scroll bars to see all of the frames in the 
application.  To check your screen size, take the following steps. 
1. Click on the Start Button in the lower left hand corner of your computer. Go to Settings > 

Control Panel.  
2. From the Control Panel window double click the Display icon.  This will bring up the Display 

Properties window. 
3. In the Display Properties window select the Settings tab by clicking once. 
4. In the Settings tab there is an area labeled Screen Area.  There is a button that can be moved 

left or right to select the screen size in pixels.  Below this button the current screen size will be 
shown.  If it is already set at 1024 x 768, click on Cancel and go to step 6.  To move it, place 
the mouse on the button and hold the left mouse button while moving the mouse left or right 
until you see the 1024 x 768 selection.  At this point let up on the left mouse button. 

5. At this point, press Apply to accept the new setting.  Then press OK. 
6. Close out of the Control Panel window and My Computer window. 
7. Your computer screen should now reflect the new setting. 
 

Configuring Internet Explorer 
There is a setting in Internet Explorer that needs to be established so the web pages you access in the 
KanRoad are updated upon each visit to the page.  The following instructions will guide you through the 
process of checking this setting and to change it if necessary. 
1. Bring up Internet Explorer.  The version of Internet Explorer must be at least 6.02.  To check to 

see what version is on the machine, do the following.  Start Internet Explorer by clicking the 
blue colored e (Internet Explorer) icon on your Windows screen.  Click the Help option then 
click About Internet Explorer.  A window will appear that tells you what version you are using.  
If it is any version prior to IE 6.02, contact your district administrator or call Transportation 
Planning for the KanRoad System Administrator. 

2. From the Internet Explorer tool bar, select Tools > Internet Options. 
3. In the Internet Options window there is a General tab.  In the General tab near the middle there 

is an area labeled Temporary Internet files.  Single click on the Settings button. 
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4. In the Settings window, at the top, there is an area labeled Check for newer versions of stored 
pages.  There are three possible selections in this area.  Only one can be selected.  You should 
ensure the first option; every visit to the page is selected.  If it is already selected, click Cancel.  
If it is not selected, select it by a single click on the button then click OK. 

5. Click OK on the Internet Options window. 
 
 
Security 
Access to the KanRoad System begins with the KanRoad Home Page. 
  
The Login option will bring up the DTNT Login window.  The Login option leads the user to areas of the 
system where updates can be made. Security has been designed via the DTNT User Name and Password to 
get into this area. 
 
KanRoad has been designed to have a System Administrator, several user administrators and users. The 
system administrator is located in Transportation Planning; they will establish and maintain overall 
security of the system.  The System Administrator will establish user administrators in each district office 
and/or area office.  These are usually the District Computer Technicians.  The user administrator’s primary 
responsibility will be to set up user accounts for users in the office that will need access to KanRoad.  The 
users will be those persons who have access to the system to enter and maintain information in KanRoad. 
 
User accounts for KanRoad should be set up so that the user can use their DTNT username and password. 

KDOT Intranet 
KanRoad can be accessed through the KDOT INTRANET home page http://kdotweb/ This option is Road 
Conditions.  Single click on this option and it will bring up a list of road/weather options.  Single click on 
KanRoad (CDRS/RCRS) Data Entry If the user already has a KanRoad account set up, the user will not 
see the login screen but go directly to the KanRoad base map. 
If you have problem logging into CDRS you will need to contact your District Administrator 

 

Starting the KanRoad Program 
After you have made sure your computer and browser are configured properly, you can 
start working with the KanRoad program. In the Address field in Internet Explorer, type in 
the http://www.kanroad.org your system administrator will provide you with this address. 
If you are a registered user, you are automatically logged into the system. If you are not a 
registered user, you will see a Login screen where you can either enter your username and 
password, or enter the system as a Guest. Refer to the following sections for instructions 
the different ways to log in. 
 
 

 Working with the Map 
The map that displays in the center of the window provides information about the road 
weather conditions in the entire state and also displays road work activities with 
information about construction, detours, or road closures.    
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You can move your mouse over the map; tool tips displays that describe many different 
features in the map. 
 
You can review the following types of information when you are looking at the map: 
Regions:  Kansas has six different regions (Districts). When looking at the 
statewide map, you can see the six regions (Districts) by the bolded gray 
outline. Placing the mouse over counties will display the county names. Note 
that when you are looking at a map of the entire state, only primary roads 
display. When you display individual regions or zoom in within a region, more 
roads will display 

 

 
 

1. Enter your username and password, and then select the Login button. If you do not 
know your username and password, contact your system administrator. 

2. The following prompt displays: 

 
3. Select No.    
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Using the CDRS Data Entry Button 
 
The CDRS Data Entry button allows you to add new alerts and to edit existing alerts.   
 

Edit Alert Bulletin Search 
When you select the CDRS Data Entry button, the following screen displays. The Edit 
Alert screen displays automatically. You will use this screen to search for alerts for either a 
district, area or a county. When you submit the search query, a list of all the alerts for the 
area display, and then you can edit the alert.  
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Filling in the Fields in the Edit Alert Bulletin Search 
1. From the Alert Status drop down list, you can narrow the selection of the alerts types 

if you so desire.  
2. First, select the Query Listing Return Type. If you select Text, the alerts will 

displays in text format. If you select Map, the alerts will display on a map.   
Press the Go Get Listing button now, to view a listing of current alerts. If you want to 
narrow down the types of alerts to view, you can select from one or more of the options 
listed. 

 
 

Click on one of the diamonds to display a window where you can edit the alert, view it, 
suspend it, or expire it.  
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If you selected Map for the Query Listing Return type at the top of the Edit Alert Bulletin 
Search screen then a map will display with the alerts as shown on the next page. The alerts 
display as diamonds.  
 
Optional Search Fields: 
To narrow your search, you can select items from one or several of the following fields. 
They are all optional. 
1. Error! Bookmark not defined.From the Select Time Constraint drop down list, 

select the time frame for the alerts you want to view. This option is only available is 
you selected Becoming Active, Recently Active or Becoming Expired from the 
Alert Status list. You can choose options between one week and one year. For 
example, if you choose one week, the alerts within the last week display. If you select 
one year, all of the alerts from the last year display. 

2. From the Location drop down list, select the location for which you want to view 
alerts. You can select a district, a district and an area, or a county.  

If you want to select an Area to use in the search, be sure to first select the 
District. You can use the Map button to display a map of all the counties in 
Kansas. Click on the county for which you want to view alerts, then close the 
map window. The county you selected displays in the Edit Alert window. 

3. From the Route drop down list, select the type of route for which you want to view 
alerts. You can choose from the All Interstate Routes, All US Routes, All Kansas 
Routes, or select a specific route number: 

4. From the Traffic Routing drop down list, you can select the detour type for the alerts 
you want to view.   

5. You can define different restrictions to use in the query. Select the check box to turn 
these options on, and then type in the restriction in the white field. Enter width and 
vertical restrictions in feet, and weight restrictions in pounds. If you just select the 
check box and do not enter a value, all alerts with any type of restriction will display. 
If you enter a value, then alerts with values less than or equal to the number you 
entered will display. 

 

 
 
6. After you have filled out all of the fields that you want to use, select the Go Get 

Listing button and the Alert Bulletin Listing window displays. If there are alerts that 
match the criteria you entered, they will display. If no alerts match the criteria, a 
message will tell you there were no matches.  
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Editing an Existing Alert 
When you click on a diamond from the Alert Bulletin Listing, the window shown below 
displays (the entire page will not display on the screen all at one time, you will need to 
scroll down to see all of it): See the next two screen shots. 
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The window that displays for editing alerts is exactly the same as the one you use when 
creating new alerts. For details see adding a new alert on any field. When you are done 
editing the alert, select Submit for Approval and the alert will be updated.   
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Adding a New Alert 
You can add a new alert from the CDRS Data Entry screen. New alerts are for road 
closings, bridge closings, lane width restrictions, restricted vertical clearance, ramp closing, 
weight limits, width limits, height limits, or other circumstances where the normal flow of 
traffic is interrupted.  

 

Enter New Alert Bulletin – Step 1  
1. First, select the New Alert button from the CDRS Data Entry screen. The following 

window displays: 
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2. You must enter information for all of the drop down lists in this window. Start with the 
Alert Type. Select from the following types: 

 

 
 

3. From the Alert Description drop-down lists, select a description for the alert. For 
example, if the Alert Type is a Road Closing, the description field will explain why 
the road is closed (road construction, road overlay, and so on). 

4. From the Route drop down list, select the route number for which you want to issue an 
alert. The routes display in numerical order in this list. 

 
The route you select determines the options that are available in the Lanes 
Affected, Begin County, and End County lists. Only items that are relevant 
to the route you selected will display.   

5. From the Direction list, select which lanes on the selected route are affected.  
6. For the Begin County list, select the county where the alert should begin. Only the 

counties that the selected Route exists will display.  

 When you select the Begin County, the same county name will display in the 
End County field. You can select a different end county if necessary. 

 
7. For the End County list, select the county where the alert should end.   
8. In the Select Begin and End Location Choice, you must enter information in one of 

the available fields (State Logmile, Reference Post, or Latitude/Longitude). Select 
one of the following buttons: 
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State Logmile: 
The State Logmile section contains the Begin State Logmile and End State Logmile 
fields. The options that display consist of all intersection data as well as bridges, 
culverts (500 series), county, and city boundary information.  

 The State Logmile and Reference Post fields will only display items 
relevant to the counties you selected.  
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Reference Post: 
The Reference Post section contains the Begin and End Reference Post options. 
These two lists are comprised of reference post numbers for the begin and end 
counties.  
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Latitude/Longitude: 
 
The Latitude/Longitude section provides the option of entering the 
latitude and longitude coordinates for the alert.  
 

 
 

The Latitude and Longitude entries must be in the Base Map coordinate system, 
Lambert Conformal Conic. For example, enter the latitude as 38.426356099943 and 
the longitude as -95.8396989347783. Latitude and Longitude entries will be validated 
when you select the On to Step 2 button. You must enter coordinates that are valid for 
the Route and Counties you selected. If the coordinates are valid, the window for Step 
2 will display. If the coordinates are not correct, an error message will display: 
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9. When you are done entering all the information in this window, select the On to Step 
2 button to go to the next window.  

Enter New Alert Bulletin - Step 2 
The screen for Step 2 displays all of the information you just entered and provides an 
interface to enter additional information for the alert. You must enter information in the 
fields that display with a red asterisk (*). (See the next two screen shots) 
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Required Fields: You must enter information in the following fields: 
Area:  You can select an area within the selected district to use with the alert.  
Alert Status:  Select from Planned, Active, Suspend or Expire.  
Closed:  If the road is closed, select this box to display a check mark. 
Beginning Date:  You must specify a beginning date for the alert. Click the calendar icon 
to display an interactive calendar (shown on the next page). Select the month when the alert 
should start. Use the blue arrows to change the year. Then, select the date from the 
calendar. When the date is entered, select the Begin Date button, then select the Close 
button. The Beginning Date will display in the main window. 
 

 
 
Est. Completion Date:  You must specify an estimated completion date for the alert. Click 
the calendar icon to display the same calendar that displayed for the Beginning Date. Use 
the arrows to change the month and/or year. Then, select the date from the calendar. When 
the date is entered, select the Est. Completion Date button, then select the Close button. 
The Est. Completion Date will display in the main window. 
Expiration Date:  When an alert is canceled, you will need to edit the alert and enter an 
expirations date. Click the calendar icon to display the same calendar that displayed for the 
Beginning and Estimated Completion dates, and follow the same steps to enter the 
Expiration Date. Select the Expiration Date button on the calendar when you are done, 
then select the Close button. 

Begin and End Fields:  These fields will display information based on the State Logmile, 
Reference Post, or Latitude/Longitude information you entered in Step 1. You can modify 
the information as necessary.  The Project Length is the calculated length of the Begin 
Location and the End Location fields. This field will dynamically change as you edit 
either of the location fields. 
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Begin and End Description:  If you entered a State Logmile in Step 1, a description will 
display in these fields. If you entered Reference Post or Latitude/Longitude, you must enter 
a description. 
Time Delay: Select a time delay to display with the alert from the drop down list. 
Reported By: This field will automatically display your user name. 
Contact: Select your contact information or your district’s contact information from this 
list.   

 
The user names that display in this list are the District Administrators for the 
specified district. If another user needs to display in this list, contact your KanRoad 
District Administrator. 

 
 
Optional Fields: It is optional to enter additional information in the following fields 
Project Number: This field allows you to enter a construction project number. 
Direction Affected: This field allows you to choose which lane(s) are affected. 
FHWA: See instructions below. 
Vertical/Width/Weight/Speed: These fields allow you to enter additional restrictions for 
this alert. 
Detour Type: See instructions below. 
Posted Bridges (Det.): Allows you to enter information on posted bridges on detour route. 
Speed Rest (Det.) Allows you to enter speed limit on detour route. 
Detour…: Allows you to enter detour information for the alert. 
Public Comments:  This field is populated with the information in the Alert Comments 
field. These are comments that will be available on the public web page. The Public 
Information Officer (users with Enter Public Comments privileges), can edit this field to 
add additional comments. A spell check will be performed on these fields during the 
approval process. Enter any additional information that the public needs to see on the 
Public web page. Personnel with the Public Information Office could edit this field if 
necessary. 
Description of Alert Comments: This field is initially populated with the information that 
displays in the Begin Description and End Description fields. You can edit this field to 
add additional comments.  A spell check will be performed on these fields during the 
approval process. Add any additional information that is required to this field 
.Alert Hyperlink:  You can enter a web link in this field (for example, www.kanroad.org). 
Be sure to enter only web address but not the http:// portion. If you click on an alert in the 
Public Map window, then review Alert Details, the hyperlink will display in the report. 
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FHWA:  This window allows you to enter information about unplanned road closures 
and traffic incidents for the Federal Highway Administration. If you fill out this window, 
an email will be paged to FHWA with the information you enter when you submit an alert. 
Using this button will eliminate the need to call the FHWA for road closures as stated in 
the Maintenance Manual.  The following window displays when you select this button: 
 

 
 

 
The ‘ALERT’ is to be used to make notification of various emergency occurrences involving the 

Kansas highway network.  See FHWA ALERT instructions below.  
 
All fields on this screen are optional, use only the ones necessary for the closure or incident. 

FHWA ALERT INSTRUCTIONS 
An FHWA alert is used to inform FHWA of unplanned road closures and traffic incidents which 
meet any of the following guidelines. 

1. Road closures due to snow, ice and high water.  
2. Highway related incidents which impact highway operations due to natural disasters such 

as floods, earthquakes and tornado’s.  A terrorist incident involving a highway facility. 
3. Any incident that causes a major highway (K, US & I-routes) to be closed for more than 8 

hours except where the public has been notified in advance via newspapers, radio, or 
television announcements.  
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4. Any incident that causes major damage (in excess of one million dollars) to the highway 
network. 

5. All bridge failures or emergency closures of regionally important structures. Indicate if the 
closure is related to a bridge inspection.  

6. Any incident involving hazardous materials, fire, explosion or release of hazardous 
materials. 

7. Any incident that creates national media attention. 
8. Any chain reaction incident where more than 20 vehicles are involved, regardless of the 

number of injuries. 
9. Any incidents involving the deaths of 10 or more people or any incident involving a school 

bus resulting in serious injuries or deaths to school children. 
 

Note: When the Alert has ‘Expired’ the FHWA button will have to be pressed 
again. 
When you are done, select Submit, and you are returned to the Step 2 alert window. 

 
If you open this window a second time (for example, to double-check the detour 
information), you MUST select Submit to exit the window and include the detour in 
your alert. If you select Cancel, the information will not be included with the alert.  

 

Submitting the Alert 
When you are done defining all of the information in Step 2, select the Submit Changes 
button. If you are missing one or more required fields, the following message will display: 
 

 
 

The fields you need to correct will highlight in red so you can easily find them. Enter the 
required information and select Submit for Approval again. When all the necessary 
information has been filled out, the following window displays: (See the following two 
screen shots) 
 

Filling out the Detour Data Entry window: 
1. Select Detour Type.  
2. If a detour is required for this alert and the detour has posted bridge(s), check the 

Posted Bridge(s) check box.  
3. The File Upload button will allow you to access images available on either your 

machine or a KDOT server that describe the detour. Select the File Upload button, and 
browse to the directory location where the file is stored.  
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4. If no detour image is currently available, you can build a detour image map. Select the 

Digitize Detour button and a map of the section of road that you defined in the alert 
window displays. The entire section of road that is included in the alert displays in this 
window. The alert bulletin route displays in yellow.  
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5. Use the scale drop down to zoom in or out on the map view.  Larger scale numbers 

will zoom out and show more map area. 
6. The cursor will appear as a hand icon.  To select the detour route, position the cursor 

over the desired road segments.  The segment highlights in dark blue.  Click the 
segment to select it.  When selected, the segment will display in purple. 

7. When you are done selecting the detour route, press the Create Detour Image button. 
8. The detour route displays on the map. The detour route displays as a bold purple line 

on the map. 
9. Add Detour Comments (this field is required). Run Spell Check (required). 
10. Select Submit. After a successful submittal, the following message will display in the 

detour map window.  Select Exit to close the digitize detour window. 

--Detour Information Updated— 
The detour information has successfully been updated. 

 

 
If you open this window a second time (for example, to double-check the detour 
information), you MUST select Submit to exit the window and include the detour in 
your alert. If you select Cancel, the information will not be included with the alert.  
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Detour Details Option 
Detour: This button allows you to describe a detour around a closed road or construction 
work. When you select this button, the following window displays: 
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Also, a map of the alert area, a map of the detour (if applicable) and FHWA information (if 
applicable) will all display in this window. Move your mouse over the highlighted road and 
information about the alert displays.   
The middle section of the window shows the roadway affected by the alert.  

 
 
The bottom part of the screen shows information about the detour and FHWA information. 
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Review all of the alert information both in the text window and on the map. If the alert 
information is correct, select the Submit button at the bottom of the window and the alert 
will display on the Kansas map. There is a five minute delay before the alert displays on the 
public site. If you need to correct some information, select Cancel to return to the New 
Alert window. You can correct any of the fields and submit again.  
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Using the RCRS Data Entry Button 
 

The RCRS Data Entry screen allows you to update all SNICE and road condition information.  When you 
select the RCRS Data Entry button, the following screen displays: 
 

 
 
 
Selecting a SubArea: 
The first thing you need to do when updating SNICE and Road conditions is to define the Sub Area for 
which you want to set SNICE and/or road conditions.  There are two ways to select a subarea: 
graphically or from a drop-down list. 

1. To select a subarea from the drop-down list, select the arrow next to the Select SubArea 
box.  A drop-down list displays. 

2. Scroll down until you see the subarea you want to modify and click on it.  The SubArea 
displays in the white text field. 

3. Select the Update SubArea button to open Kansas Subarea Update screen.   
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OR 
1. To select a subarea from a map of Kansas, select the RCRS BaseMap button on the left side of 

the window.  A map of Kansas display. 
2. Now, select the District and Area that contains the SubArea you want to update.  Move your 

mouse over the map, and the names of the District and Area of each section of the map 
displays.  Click the left mouse button to select a District and Area.  The map will change to 
zoom in on the District and Area you selected.  

3. Move your mouse over the map, and the District and Area numbers display in the map.  Click 
the left mouse button to select a District, Area, and SubArea, left mouse button again to select 
the Subarea you wish to enter data. 

 
 
Updating Road Conditions 
 
The Kansas SubArea Update window is where you update all SNICE and road condition information. 
After a SubArea has been selected to update, this section will describe each step in updating the 
information. 
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Dialog Controls 
The Dialog Controls section of the window is read-only except for the Exit Dialog button.  The Exit 
Dialog button allows you to exit and go back to the previous page.  The report date and time (the current 
date and time when you opened this data entry window) along with the subarea you selected display in this 
window.  The Report Date and Time are used as the default for setting SNICE Begin Time and the 
condition times. 

1. First select route segment description you want to edit. You can pick one or several routes. 
Each route you select highlights in red. The extended controls button allows you to easily 
select all of the routes listed or to deselect all of the routes. 

2. Next go to the top of the screen in the Set Time Controls section and click on Set SNICE 
Begin Time. A message box will appear, select OK and selected routes will turn GREEN. 

 
The Set Time Controls area is where you set the date and time for SNICE begin times and for road 
condition report times.  The buttons on the window, Set Road Condition Time and Set a SNICE Begin 
Time are only activated at the times that they are appropriate.  This is designed to minimize errors and 
mistakes.  The boxes for selecting the dates and times are pull down boxes.  The minute pull down box 
only allows 5-minute intervals. Routes which have been selected will turn BLUE. 

 

 
 

Click Set Road Condition Time, select routes will turn BLUE. 
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3. Next go to The Road Condition/Update Controls area where you select road conditions. 
Click Select New Road Conditions: and a pull down menu of the road conditions is at the 
top of the area.   

 
There are three buttons available in this window: Set Condition, Refresh Times, & Commit Updates. Click 
Set Condition button defines the condition for the selected route segment. The selected routes will turn 
PURPLE or click the Refresh Times button (when the condition does not change but you want to update 
the condition time. (This is usually when a condition lasts longer than 4 to 6 hours.) Routes will now be 
purple. When you select this button, the following message displays: 

 
 

Extended Messages 
 

4. Optional Extended Messages. With rows still highlighted in PURPLE this field allows 1 
or 2 descriptive messages to be added to the tool tip to better describe the situation. Click 
on Extended Messages Button, select from Msg 1: or Msg 2: drop down box.  This list of 
messages is predetermined, but a System Administrator can add new messages.    Listed 
below are the current messages and codes. 
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5. The Commit Updates button updates the database after confirming that all the data is 
correct. Click on the Commit Updates. A message box will appear select OK. All routes 
will be changed to GRAY. 

6. Click on Exit Dialog. Map will update. You can now choose another SubArea or LogOut.  
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Error Color Code 
This line is a legend showing what the colors mean when you encounter them during the data entry 
process.  As you are going through the workflow of entering SNICE or road condition information there 
are various stages and steps in which information is highlighted in different colors during each stage.  The 
color-coded system helps you know what to do next or what error might have occurred. 
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Help Screen 
At any time while you’re working with this window, you can select the? button at the top corner of 
the window to display the help screen 
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Updating Closed Conditions  
At the RCRS entry home page 
The Closed Conditions button displays all of the currently closed roads, and provides a way to provide a 
better description of the condition/situation, through extended messages. 
In order to use this feature, you must have the road segment coded as closed. 
 

 
 
Listed below are some examples of where this extra feature can be used: 
I-70 CLOSED at Goodland, but motels are available at Oakley. 
US-56 CLOSED at Elkhart at the request of Oklahoma. 
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To edit the information about the closed road, click the Edit Message(s) button for the road condition you 
want to edit.  The following window displays: 
 

 
 
 
1. First, select Route Segment Description you want to edit.  You can pick one or several routes.  

Each route you select highlights in green. 
2. Next, go to the top of the window in the Set Time Controls section and set the Expected 

Reopening time.  Use the drop down lists to choose the month, day, year, hour, minute and 
AM/PM for the expected reopening.  When you are done, select the Set Extended Reopening 
Time button.   The reopening time you entered displays in the middle section of the window 
labeled Re-opening. 

3. Now you can define extended messages, provide information about the exact closed section of 
the road, and add comments about available hotels or other accommodations. 

4.   First, select an Extended Condition message, from the drop down box. 
5.   Next, select the Reason for Condition, from the drop down box. 
6.   Next, you can enter major details about the portion of the road that is closed in the Closed 

from and Closed to fields.  To enter information into these fields, select the button next to the 
fields, then enter whatever information is relevant.  These fields are optional. You are not 
restricted to predetermined messages. 

7. If you want to provide information about accommodations, such as there is a hotel at exit 25, 
enter this information in the Accommodations field. 
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8. After you are finished entering information, select the Green Set Messages button.  The Route 
Segments you select in step one change from Green to Pink, and the new messages you added 
display in the list. 

9. Review the messages.  If the information is correct, select the Pink Commit Message button.  A 
window will display asking you if you want to update the message. 

10. Select OK and the message is updated. 
11. Select the Exit Dialog button in the upper left portion of the window to return to the Closed 

Condition list.  You can now update other closed conditions if necessary. 
 
 
Stale Segment Notification 
We have built into this system an automatic notification through an email to inform the user of the system 
that there is stale data.  This feature will E-mail the person that input the data and also to a District account 
only once whenever a road condition remains the same during a SNICE event for more than 8 hours if the 
condition time has not been updated or refreshed.  You should only get one message per road condition 
change.  Please do not be offended if you feel these messages are in error.  This is just a reminder to help 
keep our data current and correct for the traveling public.   
 

Reporting Problems with RCRS 
If you experience problems logging into RCRS your first contact should be at the District level.  This may 
be your immediate supervisor or someone at the District. 
 

District Administrator for District ______ is __________________________________________ 
 
 
If you experience a problem with the system being down or not updating please call the KanRoad 
Administrator, in Transportation Planning. Contact Names and phone numbers can be found on 
KanRoad home page in left column under KDOT Help!!! Phone Numbers 
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Historical Reports 
 
You can use the Historical Reports button to search for different road work and/or road 
conditions and generate a text report.  

Setting up a Report 
To create a report for specific road work or road conditions, select the Hist Reports button 
at the top on the KanRoad Basemap screen.  
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The Reports screen displays. 
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Step 1: Selecting the Subject 
The first step is selecting the type of information to search for. Select one of the following 
options. 
 

 
 

• All Road Work Construction: This option searches for all roadwork projects. 
• Select Road Work Activity: This option allows you to search for only certain types of 

roadwork. Select one of the following options: 
 

 
 

• All Roadway Weather Conditions: This option searches for all weather conditions. 
• Select Roadway Weather: This option allows you to search for only certain types of 

weather conditions.  
 

After you work through this section, you should have one item selected.  
 

Step 2: Selecting an Area 
After defining the type of road work or weather conditions you want to search for, you can 
define the area of the state to search. Select one of the following options: 
State:  Searches for the road work or weather conditions for the entire state. 
Region:  Searches for the road work or weather conditions for a specific District of the 
state.  
Area:  Restricts the search to a specific Area in the District you selected.  
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Select County:  Searches for the road work or weather conditions only in a certain county.  

Step 3:  Selecting a Route 
You can select All Routes to use all of the roads in Kansas for the query, or you can pick 
the Select Route option to search on a specific road. 

Step 4:  Selecting the Date Criteria 
In Step 4 you enter the date criteria to use in your search.  
 

 
 
No Date Criteria:  Select this option if it doesn’t matter when the road work or weather 
conditions occurred. 
Before a Date:  To search for road work or weather conditions with a start date before a 
specific date, select this option. Select a date from the menu at the bottom of this section. 
After a Date:  To search for road work or weather conditions with a start date after a 
specific date, select this option. Select a date from the menu at the bottom of this section. 
Between Dates:  To search for road work or weather conditions that occurred between two 
dates, select this option. Select a start date (the first row) and finish date (the second row) 
from the menu at the bottom of this section. 
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Step 5:  Selecting a Time 
In Step 5 you enter the time criteria to use in your search. 
 

 
 

No Time Criteria:  Select this option if it doesn’t matter what time the road work or 
weather conditions occurred. 
Before Time:  To search for road work or weather conditions that occurred before a 
specific time, select this option. Select a time from the menu at the bottom of this section.  
After Time:  To search for road work or weather conditions that occurred after a specific 
time, select this option. Select a time from the menu at the bottom of this section.  
Between Start and End Time:  To search for road work or weather conditions that 
occurred between two times, select this option. Select a time from the menu at the bottom 
of this section.  

 
After completing step 5, you have entered all of your query criteria and are ready to 
generate a report. You can go back and change any of the query fields if necessary. 

Step 6: Creating a Report 
After filling in fields one through five, go to the Create Report section. You can select the 
units of measure, English or Metric, for the report. Then, select the Create Report button.  

 
If data matches your query criteria, a report displays.  
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If no data matched your search criteria, the following message displays: 

There is no data available that matches the criteria selected. 
To select different criteria, select the Historical Reports button. 
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You can select the Printer Friendly Version link to display a new window without the 
buttons at the top of the window.  

 

 
 
To print the report, select File > Print from the Internet Explorer menu bar. You can also 
save the report by selecting File > Save As from the menu bar to save the file in, .html, or 
.txt format. Just enter a name for the file (in the File name field), the type of file to save, 
and the location to store the file. Do not change the Encoding field. You can then open the 
report later to review or print. 
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Mapping All Alerts  
You can select the Map Alerts button to display a list of all of the roadway alerts in the 
state and to display a map showing the location of all the roadway alerts.  This map will 
replace the Construction and Detour Map that is published monthly. 
The following picture shows the alert map. You cannot manipulate the map like you can 
with the Public View button. However, you can print this map to either 8.5 x 11 or 11 x 17 
sized paper for a good printed copy. To print the map, select File > Print.  
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This picture shows the alert report. This is printed when the alert map is printed.  
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 Public View 
This section explains how to use the Public View button and the interactive map screen.  

Using the Interactive Map 
When you start the KanRoad web page, select the Public View button at the top of the 
page, make sure interactive radio button is checked in the navigation frame for interactive 
maps to display otherwise the map will be a static view of Kansas with no tooltips 
available.   
 

 
 
 
 
 

Map Frame Banner Map Window 
Information 
Frame Navigation Frame 
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The main screen is broken into three frames:  
Navigation Frame:  The top two check boxes control what kind of information will 
display on the Kansas map. The next two radio buttons control what kind of map you want 
to view, either Interactive or Static, it is recommended to choose the Interactive Maps. The 
middle set of links will display maps of different sections of the state (for example, if you 
select the Northwest link, the map will display the northwest section of the state).  The 
Additional Links section provides links to other web pages you may find useful.  The 
navigation buttons allows you to zoom in and out on the map.  
Map Frame:  The map that displays in the middle of the screen shows information about 
the current road conditions and current alert bulletins. You can move your cursor over the 
roads to see pop up windows, (i.e. tool tips) if you have Interactive maps selected  that 
describe the road conditions. You can also click on the colored diamonds (alerts) to read a 
detailed description of the alert in the right frame.  
Information Frame:  This section of the screen displays a legend for the symbols that 
display in the map, and also a legend for the road condition colors that display. If you click 
on an alert diamond in the map, a detailed description of the alert displays in this column.  
Banner:  This is the area above the State map where the Tabs or buttons are located. 
 
 

Working with the Commands in the Navigation Frame 
You can use the options in the left column to control what displays in the Map window and 
to also change the information displayed. 
 
You can control the information that displays in the map with the check boxes at the top of 
the left column. By default, both of these options are turned on: 
 

 
 
If you want to ONLY view road weather conditions (such as wet/slush, or Partly 
Snowpacked/Ice, and so on), select the Road Work Activities check box. The check mark 
will disappear, and the road work activities will not display in the map. 
 
If you want to ONLY view road work and detour information, select the Road Weather 
Conditions check mark. The check mark will disappear, and the road weather conditions 
will not display in the map. 
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Using the Routes in Kansas Links 
You can display different regions or metro areas with the links in the left column. The 
regional or metro display shows greater detail than the statewide view. Just select the part 
of the state you want to display in the Map window. You can select from the following 
options: 
 

 
 
Just select one of the links, and the map will change to display the area you selected. To go 
back to the map of the entire state, select the Statewide button in the Navigation Frame. 
 

Using the Additional Links  
The Additional Links section provides links to additional information about the KanRoad 
software and road information. The following options are available: 
• Text Reports: (In the top banner) this option displays a window that allows you to 

create a report about road and weather conditions without using the interactive map.  
• Disclaimer:  This displays a window that provides legal information about the KDOT 

and KanRoad web pages. 
• Printing: This gives you instructions on how to print from KanRoad. 
• Closed Roads: This will give the user a list of all the closed roads in Kansas, the list will 

appear in the right Information frame. 
• Help:  Displays the online Help files in a second Internet Explorer window. If you have 

questions about the software and want to look up information online, click this button. 
• Nationwide Traffic Information: Displays the National Traffic and Road Closure 

Information webpage in a second Internet Explorer window. You can go to this web 
page to find out information about roads in other states. 

• KDOT Home:  Displays the KDOT Internet home page. 
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Working with the Reports Option 
If you select the Text Reports button in the top banner, the following window displays. 
This window allows you to search for road work/detours or road conditions using a text 
listing.  Fill in the fields with the information you want to review, and select Create 
Report.  The Public only has access to current conditions; they do not have access to 
historical reports.  

 
 
 
 

1. Pick the Select Entire State button or select a specific region or county.  
2. Pick either Select All Routes or a select a specific route from the pulldown menu. 
3. Select Create Report, and all of the roads matching the options you selected display. 

The report will show all of the current road weather conditions as well as any road 
work activities for the road(s). 
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The top portion of the report shows all of the road weather conditions. 

 
 

The bottom portion of the report shows current road work activities. 

 
 

You can save the report by select File > Save As from the Internet Explorer menu bar.  
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Printing a Report 
4. To print a report, select the Printer Friendly link at the top of the window. A new 

window displays with all of the report information. This window just ensures that that 
information will fit on an 8.5 x 11 sheet of paper. 

5. From the Internet Explorer menu, select File > Print.  
6. Select the Print button at the bottom of the window. A copy of the report prints. 

Using the Information Frame (Legends) 
In the right column of the Maps window, two legends display. The top legend is for road 
work/detours. The lower legend is for road conditions. 

Working with the Road Work Legend 
Three diamonds may display in the map window. The diamonds are called Alerts and 
indicate road work projects or closed roads. Yellow diamonds indicate planned road work 
that has not started yet. Orange diamonds indicate active road work projects. Red diamonds 
indicate active road work projects where a road is closed. 
 

 
 
You can click on a diamond in the map window and the Road Work Legend changes to 
display detailed information about the road work. 
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When you click on an alert in the map frame, the legends disappear and 
information about the alert displays in the right portion of the window. If you want 
to re-display the legends, select the Back to Legend button to display the legends. 

 
 

 
 
Alerts:  Alerts display as yellow, orange or red diamonds on the map. Alerts identify 
construction, road closures, and other related information. You can move your mouse over 
an alert diamond and the type of alert (Planned, Active and not Closed, or Active and 
Closed) displays. You can click on the alert diamond and a complete description of the alert 
displays in the right column. 
 
Click on the View Alert Details button to display additional information about the alert. If 
a detour is included in the alert, a map of the detour will display in this window.  
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Alert ID in Map Window                         Alert Description in Right Column 

 
You can update the information that displays in this window by clicking Edit Alert Details. 
 
 

 

    Feb 06 



KanRoad  Page 55 

Working with the Weather Related Conditions Legend 
The legend that displays in the lower portion of the right column shows the different 
weather conditions that may display in the map window.  

 
 
When you move your mouse over a road in the map view, a description of the road 
conditions, along with additional information about the route, and the time the condition 
was reported. The road weather condition corresponds to the information that displays in 
the legend.  
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Road Weather Conditions:  Different colors on the map indicate different road weather 
conditions. You can move your mouse over different roads for a pop-up description of the road 
weather conditions. The route number, description of the road weather condition, and date and time 
the weather condition was set displays in the popup window. 

 

 
 
 
When you are viewing a region or metro area, there is greater detail displayed. 
City Names:  You can move your mouse over the name of a city to see a popup name of 
the city. 
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Zooming in and out 
There are many different ways you can navigate in the Map section of the window. You 
can zoom in and out, and also pan left and right.  

 
If you need to quickly fit the entire Kansas map in the map window, select the 
Statewide link from the left navigation frame. 

 
Using the Navigation Buttons 

 

 
The eight navigation button icons to the left of the map include a variety of functions for 
controlling map display. From top to bottom they are:  

Fit Map: displays the entire Kansas map in the window.   
Zoom by Area: Zooms to an area defined by a block drawn with the cursor. 
Zoom In: Zooms in by one level, defined by a mouse click in the map area. 
Zoom Out: Zooms out by one level, defined by a mouse click in the map area. 
Center Map to Point: Centers map view to a point defined by a mouse click in the map area. 
Refresh from Server: Refreshes the map view by reloading data from the server. 
Shift Pan: Shifts the map view as defined by a line drawn with the cursor. 
Display Last View: Displays the previous map view. 

 Blue Navigation Buttons 

The blue arrows around the perimeter of the map box move (or pan) the map in the direction of the 
arrow. Arrows indicate north, south, east, west, northeast, southeast, southwest, and northwest. 

Experiment with the arrows to become comfortable with navigation. 
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Appendix A 
   SNICE Reporting Guidelines 
 
A road condition report summarizing adverse road conditions should be reported at 4:30 a.m., 10:30 a.m., 
2:30 p.m., and 8:30 p.m.  More frequent reporting may be necessary if conditions mandate. 
 
A road condition report should be submitted at the beginning of a SNICE event.  A SNICE event begins 
when the roadway condition is no longer normal. 

 
SNICE is a performance measure developed to track the performance and effectiveness of snow and ice 
control efforts.  The SNICE measures are specific to each district, area, subarea, and route. 
 
Remember the road condition information is for the traveling public.  You should report when the roadway 
condition no longer is normal (SNICE begin), report any significant changes in the roadway condition 
during a snow/ice event, and report when the roadway condition has returned to seasonally normal 
(SNICE end).  
 
A SNICE event begins when the roadway condition is no longer normal.  The road condition report should 
be updated at the beginning of a SNICE event.   
 
The SNICE event ends when the road condition for the route has returned to normal conditions. The 
SNICE end time is determined automatically from the road condition of normal. 
 
Normal can be interpreted as seasonally normal road conditions, which no longer need treatment and does 
not necessarily mean dry pavement.  For instance, after it has stopped snowing and the roads have been 
treated and plowed to where they are wet and require no further treatment, the road can be reported as 
normal. 
 

There are three (3) example scenarios contained on the following pages 
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Scenario 1 
 Today is Dec 2nd. 
 Forecast: 4” snow today with flurries beginning sometime in p.m. 
 10:00 a.m. begins to snow 
 12:30 p.m. subarea crews begin treating all roads, all subarea roads are slush 
 02:30 p.m. all subarea roads are spots snowpacked/ice 
 05:00 p.m. subarea road Usxx is slush, Kxx is spots snowpacked/ice, Kxxx is spots 

snowpacked/ice 
 07:00 p.m. all subarea roads are normal 

 
 
 
 
 
 

ANSWER: 

Route  Condition   Report Time   SNICE 
Begin/End Time 
Usxx  wet/slush   Dec 2nd   12:30 p.m.  Dec 2nd   12:30 p.m. 
Kxx  wet/slush   Dec 2nd   12:30 p.m.  Dec 2nd   12:30 p.m. 
Kxxx  wet/slush   Dec 2nd   12:30 p.m.  Dec 2nd   12:30 p.m. 
 
Usxx  spots snowpacked/ice  Dec 2nd   2:30 p.m. 
Kxx  spots snowpacked/ice  Dec 2nd   2:30 p.m. 
Kxxx  spots snowpacked/ice  Dec 2nd   2:30 p.m. 
 
Usxx  wet/slush   Dec 2nd   5:00 p.m. 
Kxx  spots snowpacked/ice  Dec 2nd   5:00 p.m. 
Kxxx  spots snowpacked/ice  Dec 2nd   5:00 p.m. 
  
Usxx  normal    Dec 2nd   7:00 p.m.  Dec 2nd   7:00 p.m. 
Kxx  normal    Dec 2nd   7:00 p.m.   Dec 2nd   7:00 p.m. 
Kxxx  normal    Dec 2nd   7:00 p.m.  Dec 2nd   7:00 p.m. 
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Scenario 2 
 
 Today is Nov. 30th 

 Forecast:  2”-4”  snow tomorrow beginning mid-morning 
 03:00 a.m.  begins to snow 
 05:00 a.m.  subarea crew begin treating all subarea roads, all roads are mostly snowpacked 
 08:00 a.m. Ixx is spots snowpacked/ice, Usxx is mostly snowpacked/ice, Kxx is mostly 

snowpacked/ice 
 10:30 a.m.  Ixx is slush, Usxx is spots snowpacked/ice, Kxx is spots snowpacked/ice 
 2:30 p.m. Ixx is slush, Usxx is slush, Kxx is slush  
 5:00 p.m. all subarea roads are normal 

 
 
 
   
 

ANSWER: 

Route  Condition   Report Time   SNICE 
Begin/End Time 
 
Ixx  mostly snowpacked/ice Dec 1st    5:00 am  Dec 1st    5:00 am 
Usxx  mostly snowpacked/ice Dec 1st    5:00 am  Dec 1st    5:00 am 
Kxx  mostly snowpacked/ice Dec 1st    5:00 am  Dec 1st    5:00 am 
 
Ixx  spots snowpacked/ice  Dec 1st    8:00 am 
Usxx  mostly snowpacked/ice Dec 1st    8:00 am 
Kxx  mostly snowpacked/ice Dec 1st    8:00 am 
 
Ixx  wet/slush   Dec 1st    10:30 am 
Usxx  spots snowpacked/ice  Dec 1st    10:30 am 
Kxx  spots snowpacked/ice  Dec 1st    10:30 am 
 
Ixx  wet/slush   Dec 1st    2:30 p.m. 
Usxx  wet/slush   Dec 1st    2:30 p.m. 
Kxx  wet/slush   Dec 1st    2:30 p.m. 
 
Ixx  normal    Dec 1st    5:00 p.m.  Dec 1st    5:00 p.m. 
Usxx  normal    Dec 1st    5:00 p.m.  Dec 1st    5:00 p.m. 
Kxx  normal    Dec 1st    5:00 p.m.  Dec 1st    5:00 p.m. 
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Scenario 3 
 Today is Nov 30th 

 Forecast: possibility of heavy snow flurries with dropping temperatures 
 09:00 a.m  subarea crews pre-treat Ixx and Usxx, route Kxx is not pretreated; all subarea roads 

are normal 
 10:00 a.m.   begins to snow 
 10:30 a.m.  Ixx is slush, Usxx is slush, Kxx is slush 
 02:30 p.m.  Ixx is slush, Usxx is slush, Kxx is spots snowpacked 
 04:30 p.m.  Ixx is normal, Usxx is normal, Kxx is slush 
 07:45 p.m.  all subarea roads are normal 

 
 
 
 
 

ANSWER: 

Route  Condition   Report Time   SNICE 
Begin/End Time 
Ixx  normal   --------  ------   -------  ------ 
Usxx  normal   --------  ------   -------  ------ 
Kxx  normal   --------  ------   -------  ------ 
  
Ixx  wet/slush  Nov 30th    10:30 am   Nov 30th    10:30 am 
Usxx  wet/slush  Nov 30th    10:30 am    Nov 30th    10:30 am 
Kxx  wet/slush  Nov 30th    10:30 am   Nov 30th    10:30 am 
    
Ixx  wet/slush  Nov 30th    2:30 p.m. 
Usxx  wet/slush  Nov 30th    2:30 p.m. 
Kxx  spots snowpacked/ice Nov 30th    2:30 p.m. 
 
Ixx  normal   Nov 30th    4:30 p.m.   Nov 30th    4:30 p.m. 
Usxx  normal   Nov 30th    4:30 p.m.   Nov 30th    4:30 p.m. 
Kxx  wet/slush  Nov 30th    4:30 p.m.   -----  ----- 
 
Ixx  normal   -----  -----    
Usxx  normal   -----  -----   
Kxx  normal   Nov 30th    7:45 p.m.   Nov 30th    7:45 p.m. 
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Appendix B 
 
   Training Site Information  
 
KanRoad Training site is accessed from KDOT’s Intranet home page found at 
http://kdotweb/  
 

 
 
Click on Employee Info button on left hand side of screen. 
Click on KANROAD RCRS / CDRS Training 
When you login into KanRoad Training site you will see the screen below.   (See Figure below)  
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All functions within the KanRoad training site will work the same as the live KanRoad site. 
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Auto Login: 
If your DTNT username and your KanRoad username match, you will log right into KanRoad Training 
site and have data entry rights.  If not, you will get view only rights and will have to logout of KanRoad 
and log back into KanRoad  using the KanRoad username train and password train at the KanRoad login 
page.  The district Administrator will need to make sure that all of their data entry users also have a login 
to the training site because the training site is a different database and if you update the data entry site it 
will not update the training site for username passwords. 
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